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1 Revision History

Revision History

Version | Date Name Description

1.00 Jul, 31§t, 2009 Hikaru Okada Created as new document

1.00a Aug, 22™ 2009 Hikaru Okada Splitted into separate document, since number of pages
became large.

1.00b Oct, 23" 2009 Hikaru Okada Corrected misspelling

1.00c Dec, 25", 2009 Hikaru Okada Added procedure for Windows Vista and Windows 7.

1.00d Dec, 18™, 2010 Hikaru Okada Added product selection during installation.
Modified for Windows 64-bit edition.

1.00e Jul, 13", 2014 Carl Hikaru Okada | Added description about Windows 8.1
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System Requirement

3 System Requirement

>  Windows 2000, Windows XP, Windows Vista, Windows 7, Windows 8 or Windows 8.1.
»  ActiveX compliant development environment such as Visual Basic and Visual C++.




Setup

Setup

Please login Windows with Administrator privilege. If User Account Control (UAC) was enabled in Windows
Vista, Windows 7, Windows 8 or Windows 8.1, installation might fail. Please temporarily turn off the UAC.

4 1Install Jazz Soft Semiconductor Solution

Setting up development environment and runtime environment are same. Run setup.exe to install.

1 If previous version of Jazz Soft Semiconductor Solution was installed on the computer, please uninstall it
first. Uninstallation may be available in “Programs and Features” from Control Panel.

2 Launch setup.exe. If Microsoft Visual C++ 2008 SP1 redistributable files were not installed, they would be
installed first. Also .NET Framework 3.5 would be required to run setup.

'.:—.I i

setup.exe

3 The setup wizard for Jazz Soft Semiconductor Solution will appear on the screen. Click “Next” button.

Ziazz Soft Semiconductor S¢

Welcome to the Jazz Soft Semi

The installer will guide you through the steps required to install Jazz Soft Semiconductor Solution on
your computer.

WARNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the marimum extent possible under the law.

|
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4 Select installation folder and user account. Usually, don’t change anything and click “Next” button.

The installer will install Jazz Soft Semiconductor Solution to the following folder.

To install in this folder, click "Next". To install to a different folder, enter it below or click "Browse"".

Folder:
C:¥Program Files¥Jazz Soft¥ Browse...

Disk Cost...

Install Jazz Soft Semiconductor Solution for yourself, or for anyone who uses this computer:

@ Everyone

) Just me

Cancel ] [ < Back ] [ Next >

Please choose products to install.

[¥] Savoy and Dixe
[¥] Swing
[¥] Bop

Manuals and samples
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6 Confirmation screen will appear. Click “Next” button.

The installer is ready to install Jazz Soft Semiconductor Solution on your computer.

Click "Next" to start the installation.

Cancel ] [ < Back ] [ Next >

Jazz Soft Semiconductor Solution is being installed.

Please wait...

Next >
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8 Once installation was completed successfully, following screen will appear. Click “Close” button.

Jazz Soft Semiconductor Solution has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates to the .NET Framework.

Cancel Close
| | | |
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4.2Install HASP Driver

HASP key driver is not necessary for evaluation version, but is necessary to run as retail version. Required
software to install HASP driver was copied by installer of Jazz Soft Semiconductor Solution

Please don’t insert HASP key when installing HASP driver.

1 Click “HASP SRM Runtime” icon in [Jazz Soft] — [HASP] from Start menu.

. Google Earth
. Google Updater
| iTunes
J Jazz Soft
[ Jazz Soft Web Site

| Bop

| Dixie

| HASP

5 HASP SRM Runtime

| Savoy

| SexyM

/| Swing
, KWorld Multimedia
. Maintenance
. Microsoft Developer Metwork
, Microsoft Network Monitor 3.3
, Microsoft Office
. Microsoft SQL Server 2005
. Microsoft Visual SourceSafe
 Microsoft Visual Studio 6.0
. Microsoft Visual Studic 2008
. Microsoft Web Publishing
, Microsoft Windows SDK v6.04
. MinGW
. OpenCV
; QuickTime

Hikaru
Documents
Pictures

Music

Games

Recent Itemns
Computer
Metwork
Connect To
Control Panel
Default Programs
Printers

Help and Support

Run...

|Tll_ﬁ'—|lT'-
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2 Welcome screen will appear. Click “Next” button.

" 1] HASP SRM Run-time Setu [

Welcome to the HASP SRM
Run-time Installation Wizard

It iz strongly recommended that you exit all Windows programs
befare running thiz setup program.

Click Cancel to quit the setup program, then cloge any programs
wau have rnning. Click Mest to continue the installation.

WARMIMG: This program is protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of this program, or any

portion of it, may result in zevere civil ahd criminal penalties, and
will be prozecuted to the masimum estent poszible under law.

Aladdin

NICURING THY GLOEAL VILLASE

< Back [ Mext > ] [ Cancel

3 Confirmation screen will appear. Click “Install” button.

" 12| HASP SEM Run-time Setu T

Ready to Install the Application
Click, Mest to begin installation.

Click the Back button to reenter the installation information or click Cancel to exit
the wizard,

Wize Installation Wizardy

< Back ][ et > ] [ Cancel

-10 -
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4 Actual installation will start.

“12] HASP SRM Run-time Setup k

Updating System

The features you selected are currently being installed.

‘wize Installation ‘wizardy

Cancel

5 Text on the screen will change to “Install drivers”. It may take several minutes.

=0 HASP SRM Run-time Setup. (=l

Updating System

The features you selected are currently being installed.

Install drivers

‘wise Installation ‘wizard

Cancel

-11 -
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6 Once driver files are copied into computer successfully, following screen will appear. Click “Finish” button.

" 1) HASP SRM Run-time Setu X

#Aladdin

SICURING THT GLEEAL VIRLAGE

HASP SRM Run-time has been
successfully installed.

The HASP Run-time Environment uses port 1947 to
communicate with local and remote components.
If you use a firewall, ensure that it does not block
this port.

Click. the Finizh button to exit this installation.

Einizh Canicel

-12 -
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7 Insert HASP key in computer. Following popup dialog box will appear at lower right corner of screen on
Windows Vista.

I Drver Goltaars Delallabg [

Installing device driver software

=

Aladdin USE Key Searching preconfigured driver folders...

8 Once installation was completed successfully, following screen will appear. Click “Close” button.

l Driver Software Installatiol ._L

Your devices are ready to use

The software for this device has been successfully installed.

Aladdin USBE Key Ready to use
Aladdin HASP Key Ready to use

Aladdin HASP HL Key Ready to use

-13-
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4 .3Uninstall

Uninstallation may be available in “Programs and Features” from Control Panel. Or rerun setup.exe again.

1 Run setup.exe (the one you installed). Choose “Remove Jazz Soft Semiconductor Solution” and click
“Finish” button.

B e A p———— [ =]

Welcome to the Jazz Soft Semi;
SetpWizard

I

Select whether you want to repair or remove Jazz Soft Semiconductor Solution,

(71 Repair Jazz Soft Semiconductar Salution

@ Remowve Jazz Soft Semiconductor Solution

2 Actual uninstallation will start.

-14 -
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Jazz Soft Semiconductor Solution is being removed.

Please wait...

Jazz Soft Semiconductor Solution has been successfully removed.

Click "Close" ta exit.

-15-



Tutorial

5 Tutorial
5.1 Visual Basic 2008

This tutorial will explain programming with Savoy by making a mini host application.

5.1.1 Specification of Mini Host
Following is the specification of mini host which will control a general wafer inspection tool.

®  Attempt on-line, select recipe, start inspection and collect data.
® The messages this software can send are as follows.

Select.req
Select.rsp
S1F13
S2F41
S6F12

® The messages this software can receive are as follows.

Select.req
Select.rsp
S1F14
S2F42
S6F11

® |nitial setting on equipment side had already been configured and done.
® Stream 9 and function 0 will not be processed.
® Don't check T3 timeout.

5.1.2 Create New Project

1 Launch Visual Studio 2008 and click [New] — [Project...] from File menu.

&%) Microscft Visual Studio (Administratar

Edit View Tools Test Window Help

New » | 51 Project. Ctrl+ Shift+ N -
Open * | @ | WebSite... Shift+Alt+N

Close (3| File.. Ctrl+MN

Close Solution Project From Existing Code..,

7 | Save Selected Items  Cirl+5

Save Selected temns As...

2 Choose “Windows Forms Application” from “Visual Basic” project type, and type project name and folder
name. For example, project name could be “SavoyTutorialVB2008”. If setting was OK, click “OK” button.

-16-
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Project types: Templates: .NET Framework 3.5 -

Visual C++ Visual Studic installed templates

Other Languages @Windows Forms Application @Class Library
Visual Basic

Smart Device

E_% Console Application [ElEm pty Project
Database

WCF 4 Search Online Templates..,
Web

Windows
Workflow
Visual C#
Other Project Types
Test Projects

@IWPF Application [*%€ WPF Browser Application

Office EWindows Service «*8 WPF Custom Control Library
Reporting [#5| WPF User Control Library \EWindows Farms Contrel Library
Test My Templates

A project for creating an application with a Windows user interface (MET Framework 3.5)

Mame: SavoyTutorial VE2008

Location: C:\Savoy

Solution Marme: SavoyTutorial VB2008 | [] Create directory for solution

[7] Add to Source Control

3 New project was created.

#2| SavoyTutorialVB2008 - Microsoft Visual Studio (Administrator]

File Edit View Project Build Debug Data Tools Test Window Help

- S e g % 59 - - 55| b Debug - Any CPU

PO | |2 & S| TR o i

~olutio ='_r'r'.-'|n"

2| &5 E|A

% Forml.vb [Design]

=Y
wod ol pfs B [ore W R OB | 2 2l B7 &t |[FH ] G

-

m Solution 'SavoyTutorialVB2008' (]

= @ SavoyTutorialVE2008

[=d] My Project
- Forml.wb

o5 Formi

[= ==

-17-



5.1.3 Add Savoy into Toolbox

Following procedure should be done only once.

User doesn’t have to do this again next time.

Tutorial

1 Right click on empty area on Toolbox, click “Choose Items...” from the popup menu. This may take more

than one minute until the next screen will appear.

Toolbox

Data

WPF

iy 0B EEEEEEE @

e |

I
‘
i

- = X
All Windows Forms
Common Controls
Containers

Menus & Toolbars

Components
Frinting
Dialogs

Interoperability

Reporting
Pointer

Paste
List View
Show All

Choose Items...

Sort Iterns Alphabetically

Reset Toolbox
Add Tab
Delete Tab
Rename Tab
Mawve Up

Move Down

xogpoo] ;_?.(:

There are no usable controls in
thiz arnnn Mran an item nntn this

2 Select “COM Components” tab and put check mark on “Savoy ActiveX Control module”. Click “OK”

button.

-18-
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ihom Toolbox Items EIL

| NET Framework Componenfs| COM Components |WPF Components | Activitia§|

MName Path Library

[T] SapAcquisition Control CADALSA\Sapera\COMPOMN~1\Activex!... Sapera LT Acquisi...
SavoyComm Control CA\Windows'system32\Savoy.ocx Savoy ActiveX Co...
SavoyGem Control CAWindows\system32\5avoy.oo Savoy ActiveX Co..
SavoyHsms Control ChWindows\system32\5avoy.oo Savoy ActiveX Co..
SavoySecsl Control CAWindows\system32\5avoy.oox Savoy ActiveX Co...
SavoySecsl Control ChWindows\system32\5avoy.oo Savoy ActiveX Co..

(] SavoySocket Control CAWindows\system32\ 5avoy.ocx Savoy ActiveX Co...

[T] SeriptControl Object CAWindows\system32\msscript.ocx Microsoft Seript C...

[7] SelectFile Class CAWindows'\system32\ CompatULdll CompatUl1.0 Typ... | |
[T] Shockwave Flash Object Ch\Windewshsystem32\Macremed\Flash... Shockwave Flash

[ SonicAudioPlaver Class C:\Proaram Files\Commeon Files\5onic 5... ﬁlkudioPIaver 10T.
4 m

SavoySocket Control
Language: Language Meutral

Version: 10

3 Since Savoy will be added to tool box, add new tab such as “Jazz Soft” and put them in it for ease of access
in a future, if needed.

=l Jazz Soft
Pointer
SavoyComm Control

SavoyGem Control

SavoySecs]l Control

SavoySecsll Contraol

SavoySocket Control
General

h
d
d
B SavoyHsms Control
d
d
d
=l

There are no usable controls in
this group. Drag an itern onto this

5.1.4 Paste Savoy into Form

1 Place 1 SavoyHsms and 2 SavoySecslls on the form as follows.

-19-



Tutorial

Build Debug Data Format Tools Test Window Help

IREETF - - - & - Fr Debug - Any CPU
L i
VB Forml.vb [Design] E
2008" o= Savoy Tuterial VB2008 == ="
3
Cpen...
Ornline
PP Select
= ——
g PPStat
0 O u]

2 Make button event handler function. If user clicks “Open” button, communication setting dialog box of
SavoyHsms will appear on the screen. And then establish connection, if user clicks “Open” button.
Since communication setting would be saved in “Savoy.ini” file, user doesn’t have to change the setting
next time.

Visual Basic 2008

Private Sub Buttonl1_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button1.Click
' Setup
hsms.LoadlIniFile()
If hsms.Setup("") Then
" If OK button was pressed, establish connection
hsms.Connect = True
End If
End Sub

3 If user clicks “Online” button, send S1F13 message.
Visual Basic 2008

Private Sub Button2_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button2.Click
'Send S1F13
outmsg.SML = "s1f13w{}"
hsms.Send(outmsg.Msg)
End Sub

-20-
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4 If user clicks “PP Select” button, send remote command “PP-SELECT”.
Visual Basic 2008

Private Sub Button3_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button3.Click
' Send S2F41 PP-Select
outmsg.SML = "s2f4lw{<a'PP-SELECT'>{{<a'PPID'><a" + TextBoxl.Text + ">}}}"
hsms.Send(outmsg.Msg)
End Sub

5 If user clicks “PP Start” button, send remote command “START”.
Visual Basic 2008

Private Sub Button4_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button4.Click
' Send S2F41 Start
outmsg.SML = "s2f41w{<A'START >{{}}}"
hsms.Send(outmsg.Msg)
End Sub

5.1.5 Event Procedure

Capture events from SavoyHsms control.

1 If Connected event occurs, send select request message.
Visual Basic 2008

Private Sub hsms_Connected(ByVal sender As System.Object, ByVal e As
AXSAVOYLib._DSavoyHsmsEvents_ConnectedEvent) Handles hsms.Connected
' Connected
' Send select request
outmsg.SML = "Select.req"
hsms.Send(outmsg.Msg)
End Sub

2 If Received event occurs, pass incoming message to SavoySecsll control to analyze message structure.
Visual Basic 2008
Private Sub hsms_Received(ByVal sender As System.Object, ByVal e As

AxXSAVOYLib._DSavoyHsmsEvents_ReceivedEvent) Handles hsms.Received
inmsg.Msg = e.lpszMsg

3 If incoming message requires reply message, return appropriate message such as “<b 0>”.
Visual Basic 2008
Select Case inmsg.SType

Case 0
' Data message

-21-
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If inmsg.Whit And (inmsg.Function Mod 2) <> 0 Then
' Need to reply something...
outmsg.SML = "<b 0>"
outmsg.Reply(e.lpszMsg)
hsms.Send(outmsg.Msg)

End If

4 If select request message arrives, reply select response message.
Visual Basic 2008

Case 1
' Select request
outmsg.SML = "Select.rsp"
outmsg.Reply(e.lpszMsg)
hsms.Send(outmsg.Msg)

5.1.6 Entire Source Code

That'sit. This project was created from zero, however, the number of lines of entire source code is only 55 lines
including empty lines and comments. Actual code we wrote was only 25 lines except comment lines. We
didn’t write any configuration file or data file which typically was required by competitors’ products. Competitors’
products are never as simple as Savoy.

Visual Basic 2008
Public Class Form1

Private Sub Buttonl1_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button1.Click
' Setup
hsms.LoadlIniFile()
If hsms.Setup("") Then
"If OK button was pressed, establish connection
hsms.Connect = True
End If
End Sub

Private Sub Button2_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button2.Click
'Send S1F13
outmsg.SML = "s1f13w{}"
hsms.Send(outmsg.Msg)
End Sub

Private Sub Button3_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button3.Click
' Send S2F41 PP-Select
outmsg.SML = "s2f41w{<a'PP-SELECT>{{<a'PPID'><a™ + TextBox1l.Text + ">}}}"
hsms.Send(outmsg.Msg)
End Sub

Private Sub Button4_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles
Button4.Click
'Send S2F41 Start
outmsg.SML = "s2f41w{<A'START>{{}}}"
hsms.Send(outmsg.Msg)
End Sub

Private Sub hsms_Connected(ByVal sender As System.Object, ByVal e As
AXSAVOYLib._DSavoyHsmsEvents_ConnectedEvent) Handles hsms.Connected
' Connected
' Send select request

-22-



outmsg.SML = "Select.req"
hsms.Send(outmsg.Msg)
End Sub

Private Sub hsms_Received(ByVal sender As System.Object, ByVal e As
AXSAVOYLib._DSavoyHsmsEvents_ReceivedEvent) Handles hsms.Received
inmsg.Msg = e.lpszMsg
Select Case inmsg.SType
Case 0
' Data message
If inmsg.Whit And (inmsg.Function Mod 2) <> 0 Then
' Need to reply something...
outmsg.SML = "<b 0>"
outmsg.Reply(e.lpszMsg)
hsms.Send(outmsg.Msg)
End If
Case 1l
' Select request
outmsg.SML = "Select.rsp"
outmsg.Reply(e.lpszMsg)
hsms.Send(outmsg.Msg)
End Select
End Sub
End Class

Tutorial
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Important information for Windows 64-bit edition

It is required to set as x86 mode in order to run Windows 64-bit edition environment.

configuration as follows.

Change project

Tutorial

5 Click on Configuration Manager from tool bar.

lools  Test Window Help
~. | b Debug - |Any CPU | [

6 Select <New...> from Platform.

Cormrnvirs I

Active solution configuration: Active solution platform:
Debug ~| [Any cPu
Project contexts (check the project configurations to build or deploy):
Project Configuration Platform Build
SavoyTutorialVB2008 Debug E AnyCPU E
AnE CPU
<Edit..»

7 Select x86 from New platform and click OK button.

New PP (O

Mew platform:

w

| Any CPU

Create new solution platforms

oK

-24-
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8 Check to make sure Platform is x86.

. EEEEE———

Active solution configuration: Active solution platform:

Debug ~| |86 -

Project contexts (check the project configurations to build or deploy):

Project Configuration Platform Build
SavoyTutorialVB2008 Debug [=] 86 (=]

9 Above procedure is for Debug configuration. Do same thing for Release configuration.

-25-
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5.2 C# 2008

Application we created in previous chapter was written in Visual Basic 2008. Let's make the same application
in C# 2008.

5.2.1 Create New Project

1 Launch Visual Studio 2008 and click [New] — [Project...] from File menu.

I #2] Microsoft Visual Studio (Administrator)

New » | 5] Project. Ctrl+Shift+N i
Open » | @ | WebSite... Shift+Alt+N
Close ‘3| File... Ctrl+M
j Close Solution Project From Existing Code...
=l | Save Selected Iterns  Ctrl+5
Save Selected Items As...

2 Choose “Windows Forms Application” from “Visual C#” project type, and type project name and folder
name. For example, project name could be “SavoyTutorialCS2008”. If setting was OK, click “OK”
button.

Project types: Templates: NET Framework 3.5 =

MFC Visual Studic installed templates

Smart Device (ZWindows Forms Application {5 Class Library

\T;“ﬂ (28 ASP.NET Web Application . ASP.NET Web Service Application

N @[WPF Application [Z WPF Browser Application
Other Languages e
¥ Console Application [ix Excel 2007 Workbook

D— [ Outlook 2007 Add-in B3 WCF Service Application
Smart Device E,C,'," ‘Word 2007 Document [ Windows Forms Control Library
Database % Dynamic Data Entities Web Application % Dynamic Data Web Application
Office My Temnplates
Reporting (i Search Online Tem plates...
Test
WCF
Web
Windows
Workflow -

Visual Basic

A project for creating an application with a Windows Forms user interface (NET Framework 3.5)

Name: SavoyTutorialC52008

Location: C:\Savoy

Solution Marne: SavoyTutorialC52008 | [T] Create directory for solution

[] Add to Source Control

3 New project was created.
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(& S avoy TutorialCS2008 - Micrasoft Visual Studio (Administrator]

File Edit View Project Build Debug Data Tools Test Window Help

P e | % a9 S-E | B Debug + Any CPU
Solution Explorer - Savoy... = 1 X
| & F]| &
I.: Solution "SavoyTutorial C52008" (] a2 Forml EI@
O T ovoyTutoriaCs2008
[=d| Properties
[:=] References
[E] Forml.cs
. #] Program.cs

% Forml.cs [Design]

=

5.2.2 Paste Savoy into Form

1 Place 1 SavoyHsms and 2 SavoySecslls on the form as follows.

avoyTutorialC52008 - Mi | 5t
: Edit View Project Build Debug Data Format  Tools Test  Window Help

|-~ e @ | % G339~ ™ - 51~ E | b Debug + Any CPU

tien Explorer - 5avoy.. ~ 1 X
|2 E|EE R

Solution "Savoy Tuterial C52008" (] o= Savoy Tutorial C#2008 El
[ SavoyTutorialC52008

¥ [=d Properties

3. [ References

----- A3 AxSAVOYLib
..... <0 SAVOYLib
----- <3 Systemn

----- <3 Systern.Core QDL
..... < Systern.Data i

----- <3 Systern.Data.DataSetE D”'L
----- <3 Systern.Deployment
----- <3 System.Drawing

’ %) Forml.cs [Design]

----- <3 Systermn.Windows.Forr EP Select

----- <3 Systermn.Xml S oy S |
----- <3 Systern.®ml.Ling PP Start
2 [Z] Forml.cs o i 0
----- %) Forml.Designer.cs

ey
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2 Make button event handler function. If user clicks “Open” button, communication setting dialog box of

SavoyHsms will appear on the screen. And then establish connection, if user clicks “Open” button.

Since communication setting would be saved in “Savoy.ini” file, user doesn’t have to change the setting

next time.
Visual Basic 2008

private void buttonl_Click(object sender, EventArgs €)

{
/I Setup
hsms.LoadlIniFile();
if (hsms.Setup(™))
{
/' If OK button was pressed, establish connection
hsms.Connect = true;
}
}

3 If user clicks “Online” button, send S1F13 message.
Visual Basic 2008

private void button2_Click(object sender, EventArgs €)

{
/I Send S1F13
outmsg.SML = "s1f13w{}";
hsms.Send(outmsg.Msg);
}

4 If user clicks “PP Select” button, send remote command “PP-SELECT”.
Visual Basic 2008
private void button3_Click(object sender, EventArgs e)
/I Send S2F41 PP-Select

outmsg.SML = "s2f41w{<a'PP-SELECT'>{{<a'PPID'><a™ + textBox1.Text + "'>}}}";
hsms.Send(outmsg.Msg);

5 If user clicks “PP Start” button, send remote command “START”.
Visual Basic 2008
private void button4_Click(object sender, EventArgs e)
/I Send S2F41 Start

outmsg.SML = "s2f41w{<A'START>{{}}}";
hsms.Send(outmsg.Msg);

5.2.3 Event Procedure

Capture events from SavoyHsms control.

-28-
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1 If Connected event occurs, send select request message.

Visual Basic 2008

{
/I Connected
/I Send select request
outmsg.SML = "Select.req";
hsms.Send(outmsg.Msg);

}

private void hsms_Connected(object sender, AXSAVOYLib. DSavoyHsmsEvents ConnectedEvent e)

2 If Received event occurs, pass incoming message to SavoySecsll control to analyze message structure.

Visual Basic 2008

{
inmsg.Msg = e.lpszMsg;

private void hsms_Received(object sender, AXSAVOYLib._DSavoyHsmsEvents_ReceivedEvent €)

3 If incoming message requires reply message, return appropriate message such as “<b 0>”.

Visual Basic 2008

switch(inmsg.SType)
{
case 0:
/I Data message
if(inmsg.Whit && (inmsg.Function % 2)!=0)

{
/I Need to reply something...
outmsg.SML = "<b 0>";
outmsg.Reply(e.lpszMsg);
hsms.Send(outmsg.Msg);

}

break;

4 If select request message arrives, reply select response message.

Visual Basic 2008

case 1:
/I Select request
outmsg.SML = "Select.rsp";
outmsg.Reply(e.lpszMsg);
hsms.Send(outmsg.Msg);
break;

5.2.4 Entire Source Code

That's it. This project was created from zero, however, the number of lines of entire source code is only 83 lines

including empty lines and comments. Actual code we wrote was only 30 lines except comment lines.
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didn’t write any configuration file or data file which typically was required by competitors’ products.

products are never as simple as Savoy.

Visual Basic 2008

using System;

using System.Collections.Generic;
using System.ComponentModel;
using System.Data;

using System.Drawing;

using System.Ling;

using System.Text;

using System.Windows.Forms;

namespace SavoyTutorialCS2008

{

public partial class Form1 : Form

{

public Form1()

{
InitializeComponent();
}
private void buttonl_Click(object sender, EventArgs €)
{
Il Setup
hsms.LoadlIniFile();
if (hsms.Setup(™))
{
/I'If OK button was pressed, establish connection
hsms.Connect = true;
}
}
private void button2_Click(object sender, EventArgs €)
{
/I Send S1F13
outmsg.SML = "s1f13w{}";
hsms.Send(outmsg.Msg);
}

private void button3_Click(object sender, EventArgs e)

/I Send S2F41 PP-Select
outmsg.SML = "s2f41w{<a'PP-SELECT>{{<a'PPID'><a™ + textBox1.Text + ">}}}";
hsms.Send(outmsg.Msg);

}

private void button4_Click(object sender, EventArgs e)

/I Send S2F41 Start
outmsg.SML = "s2f41w{<A'START>{{}}}";
hsms.Send(outmsg.Msg);

Tutorial

Competitors’

}
private void hsms_Connected(object sender, AXSAVOYLib. DSavoyHsmsEvents ConnectedEvent e)
{
/I Connected
/I Send select request
outmsg.SML = "Select.req";
hsms.Send(outmsg.Msg);
}

private void hsms_Received(object sender, AXSAVOYLib._DSavoyHsmsEvents_ReceivedEvent e)

{
inmsg.Msg = e.lpszMsg;
switch(inmsg.SType)
{

-30-



Tutorial

case 0:
/l Data message
if(inmsg.Whit && (inmsg.Function % 2)!=0)

{
/I Need to reply something...
outmsg.SML = "<b 0>";
outmsg.Reply(e.lpszMsg);
hsms.Send(outmsg.Msg);

}

break;

case 1:

/I Select request
outmsg.SML = "Select.rsp";
outmsg.Reply(e.lpszMsg);
hsms.Send(outmsg.Msg);
break;
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5.2.5 Important information for Windows 64-bit edition

It is required to set as x86 mode in order to run Windows 64-bit edition environment. Refer to above Visual
Basic 2008 sample and change project configuration.
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5.3 Visual C++ 2008

Development procedure and even source code of software for Visual Basic 2008 and C# 2008 was quite similar.
But there is much difference for VC++ 2008.

5.3.1 Create New Project

1 Launch Visual Studio 2008 and click [New] — [Project...] from File menu.

I #2] Microsoft Visual Studio (Administrator)

New » | 5] Project. Ctrl+Shift+N i
Open » | @ | WebSite... Shift+Alt+N
Close ‘3| File... Ctrl+M
j Close Solution Project From Existing Code...
=l | Save Selected Iterns  Ctrl+5
Save Selected Items As...

2 Choose “MFC Application” from “Visual C++” project type, and type project name and folder name. For
example, project name could be “SavoyTutorialVC2008”. If setting was OK, click “OK” button.

Project types: Templates: NET Framework 3.5 -

Visual C++ Visual Studio installed templates

ATL 4% MFC ActiveX Control 2% MFC Application
CLR 98 MFC DLL

General
MFC My Templates

Smart Device | Search Online Templates..,

Test

Win32
Other Languages
Other Project Types
Test Projects

A project for creating an application that uses the Microsoft Foundation Class Library

MName: SavoyTutoriaIVCZUUSl

Location: ChSavoy

Solution MName: SavoyTutorialVC2008

| [7] Create directory for solution

[7] Add to Source Control

3 Welcome screen will appear. Click “Next” button.
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alVC2008

Welcome to the MFC Application Wizard

Orverview These are the current project settings:

Tabbed multiple document interface

Mo database support

Mo compound document suppart

Customizable menu bar and toolbar interface

Visual Studio 2005 application appearance

Visual Studio project style (with explorer, output and properties panes)

Application Type
Compound Document Suppark

Database Support

L]
L]
Docurnent Template Strings :
L]
L]

User Interface Features

Advanced Features Click Finish from any window to accept the current settings.

R After you create the project, see the project's readme. txt file for information

about the project features and files that are generated.

Mext = ][ Finish ” Cancel

4 Choose “Dialog based” application and uncheck “Use Unicode libraries”. Since other settings are OK by
default, click “Finish” button.

-34-



Tutorial

MFC Application Wizard - Savo al\VC2008

Application Type

Cver s Application type: Project style:
Application Type (7 Single document (@ MFC standard

Compound Document Suppart (2 Multiple documents

Document Template Strings
Database Support (@ Dialog based
User Interface Features D Use HTML dialog
Adwanced Features

() Multiple topHevel documents
Generated Classes

Resource language: Use of MFC:
English (United States) (@ Use MFC in & shared DLL

() Use MFC in @ static library
[~] Use Unicode libraries

< Previous ] [ Mext = ] [ Finish l [ Cancel

5 New project was created.

B oy e Ve S e M
File Edit View Project Build Debug Fermat Tools Test Window Help
- e % G B9 - S5 b Debug - Win32

Solution Explerer - Savoy.. + I X ) ) )
L 6@ Savoy TutorialVC2008.rc - IDD_SAVOYTUTORIALYC2008_DIALOG [English (United States)] - D
S 4 g

o | [#% downlead

]

1] SavoyTutorialVC2008 =

m Selution "SavoyTutorialVC2008"
< & T
- [ Header Files

..... |n] Resource.h
..... |1 SavoyTutorialVC2008.
----- [0 SavoyTutorialVC2008
..... ] stdafh
..... |n] targetver.h
=~ [ Resource Files
..... |80 SavoyTutorialVC2008,
- (=4 SavoyTutorialVC2008,

- 54 SavoyTutorialVC2008.
- [ Source Files
..... ¢ SavoyTutorialVC2008,
..... ¢+ SavoyTutorialVC2008
..... Cl.j stdafu.cpp
..... | ReadMe.tut

TODO: Place dialog controls here,

5.3.2 Paste Savoy into Form

1 Place 1 SavoyHsms and 2 SavoySecsllIs on the dialog resource as follows.
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oject Build Debug Format Tools Test Window Help
Pl¥ S3@B |9~~~ 55| b Debug + Win32

W/ SavoyTutorialVC2008.rc - IDD_SAVOYTUTORIALVC2008

»rialVC2008' (

FE SavoyTutorialVC2008 [e=27)

vh
torialVC2008.
torialVC2008I

“h
3
torialVC2008.
torialVC2008.
torialVC2008.

torialVC2008.
torialVC2008I[

P

2 Assign as variable. Right click on SavoyHsms object, and click “Add Variable” from popup menu.

B3| 9 -0 - S| P Debug > Win32
oo
6& SavoyTutorialVC2008.rc - IDD_SAVOYTUTORIALVC2008_DIALOG [
CEUUSI( ESE?O}"TUtonalvczuua@
18 . -
1 & | Cut
WVC2008. || |:: .
- e Co
veao0sl || |5 il o
[ Paste
)( Delete
Add Event Handler...
WC2008. | |-
V08, Insert ActiveX Control...
vco0a, || [: g | Add Class..
‘W  AddVariable...
V2008, B
VC2008 I Size to Content
i i |= | Align Lefts
it | Align Tops
@ Check Mnemonics
Edit Control
Properties

3 Change variable type to “CSavoyHsms”. The name of “.h file” and “.cpp file” will also be “SavoyHsms.h”
and “SavoyHsms.cpp” respectively. Variable name will be “m_hsms”. Click “Finish” button.
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Add Member Variable Wizard

Welcome to the Add Member Variable Wizard

Access:
public Control variable

Variable type: Control ID: Category:
CSavoyHsms IDC_SAVOYHSMSCTRLL +  Control

Variable name: Control type:
m_hsms QCK

. file: .cpp file:

SavoyHsms.h SavoyHsms.cpp
Comment {f{ notation not required):

4 Do same thing for SavoySecsll control. Change variable type to “CSavoySecsll”. The name of “.h file”
and “.cpp file” will be “SavoySecsll.h” and “SavoySecsll.cpp” respectively. Variable name will be
“m_inmsg” and “m_outmsg” respectively.

Add Member Variable Wizard - SavoyTutorialVC2008

Welcome to the Add Member Variable Wizard

Access:
public - Control variable
Variable type: Control ID: Category:
CSavoySecsll IDC_SAVOYSECSIICTRL Control
Variable name: Control type: Max chars:

m_inmsg

.h file: .cpp file:
SavoySecsILh [..] savoysecstlcpp

Comment {{f notation not required):
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5 Variable for recipe name will be CString type and “m_strPPID”.

.
Add Member Variable Wizard - SavoyTutorialVC2008 [

Welcome to the Add Member Variable Wizard

v

Access:
public - Contral variable

Variable type: Control ID: Category:
C5String IDC_EDIT1 *  Value

Variable name: Control type: Max chars:

m_strPPID| EDIT

Comment {f{ notation not required):

Finish ” Cancel

5.3.3 Overwrite Wrapper Classes

Visual C++ 2008 has some issues regarding ActiveX control wrapper class. So Jazz Soft provided wrapper
class to solve this issue. Wrapper class could be made by Visual C++ 6.0, but “enum” is not reflected.

1 Close Visual C++ 2008 at this time.

2 Overwrite newly created “SavoyHsms.h”, “SavoyHsms.cpp”, “SavoySecsll.h” and “SavoySecsll.cpp” with
ones provided by Jazz Soft.

3 Restart Visual C++ 2008 and reload project.
5.3.4 Process Buttons

1 Make button event handler function. If user clicks “Open” button, communication setting dialog box of
SavoyHsms will appear on the screen. And then establish connection, if user clicks “Open” button.
Since communication setting would be saved in “Savoy.ini” file, user doesn’t have to change the setting
next time.

Visual Basic 2008

void CSavoyTutorialVC2008Dlg::OnBnClickedButton1()
{

/I Setup

m_hsms.LoadIniFile();

if(m_hsms.Setup("™))

{
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/I'If OK button was pressed, establish connection
m_hsms.SetConnect(true);

Tutorial

2 If user clicks “Online” button, send S1F13 message.

Visual Basic 2008

void CSavoyTutorialVC2008Dlg::OnBnClickedButton2()

/l Send S1F13

m_outmsg.SetSml("s1f13w{}");

m_hsms.Send(m_outmsg.GetMsg());
}

3 If user clicks “PP Select” button, send remote command “PP-SELECT".

Visual Basic 2008

void CSavoyTutorialvVC2008DIg::OnBnClickedButton3()
{
/I Send S2F41 PP-Select
UpdateData();
m_outmsg.SetSml("s2f41w{<a'PP-SELECT'>{{<a'PPID'><a™ + m_strPPID + "'>}}}");
m_hsms.Send(m_outmsg.GetMsg());

4 If user clicks “PP Start” button, send remote command “START".

Visual Basic 2008

void CSavoyTutorialVC2008Dlg::OnBnClickedButton4()

/I Send S2F41 Start
m_outmsg.SetSmI("s2f41w{<A'START>{{}}}");
m_hsms.Send(m_outmsg.GetMsg());

}

5.3.5 Event Procedure

Capture events from SavoyHsms control. Event handler function can be created from “Properties” window.
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Properties ~ 1 X

IDC_SAVOYHSMSCTRL] (ActiveX -

aaniu|uiny§ ;\(:

=

<Add> ConnectedSavoyhsmsctril

FTOETETTT
Received
SelChanged

1 If Connected event occurs, send select request message.

Visual Basic 2008
void CSavoyTutorialVC2008DIg::ConnectedSavoyhsmsctrl1(LPCTSTR IpszIPAddress, long IPortNumber)

/I Connected

/I Send select request
m_outmsg.SetSml("Select.req");
m_hsms.Send(m_outmsg.GetMsg());

}

2 If Received event occurs, pass incoming message to SavoySecsll control to analyze message structure.

Visual Basic 2008
void CSavoyTutorialVC2008DIg::ReceivedSavoyhsmsctrll(LPCTSTR IpszIPAddress, long IPortNumber,

LPCTSTR IpszMsg)

{
m_inmsg.SetMsg(lpszMsg);

3 If incoming message requires reply message, return appropriate message such as “<b 0>".

Visual Basic 2008

switch(m_inmsg.GetSType())
{
case 0O:

/| Data message
if(m_inmsg.GetWhbit() && m_inmsg.GetFunction()%2)

{
/I Need to reply something...
m_outmsg.SetSml("<b 0>");
m_outmsg.Reply(IpszMsg);
m_hsms.Send(m_outmsg.GetMsg());

}

break;
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4 If select request message arrives, reply select response message.
Visual Basic 2008

case 1:
/I Select request
m_outmsg.SetSml("Select.rsp");
m_outmsg.Reply(IpszMsg);
m_hsms.Send(m_outmsg.GetMsg());
break;

5.3.6 Entire Source Code
That's it. Since the entire source code consists of multiple files, | don’t put them here.

This project was created from zero, however, the number of lines in core source code
“SavoyTutorialVC2008DlIg.cpp” is only 231 lines including empty lines and comments. Actual code we wrote
was only 31 lines except comment lines. We didn’t write any configuration file or data file which typically was
required by competitors’ products. Competitors’ products are never as simple as Savoy.
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